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Manual AthleticsManager 

 

Welcome to the "AthleticsManager" user manual. 

 

May we recommend you to gently browse through the entire manual first, just to have an initial idea of how the book is 

structured. As we can't possibly explain all details simultaneously, this might help you a bit in understanding and tracing 

things back. Of course, the table of contents will also help you in doing so. 

 

Please note that all pictures are examples, the delivered version can be different than shown in this manual please 

inform yourself before purchase. 

 

AthleticsManager's functionality is extended by the software products PostgreSQL and LibreOffice, property of 
PostgreSQL Global Development Group and The Document Foundation respectively. AthleticsManager uses icons of the 
Silk and Fugue icon sets. 
 

If you, after reading this document, have any further question regarding the operation or service of this or any other 

TimeTronics equipment, please contact your local distributor or TimeTronics directly, by email: info@timetronics.be, or 

call us at +32 (0) 14 23 19 11. 

 

Please also contact us if you have any remarks or advice regarding this user manual: info@timetronics.be 

 

Good luck with AthleticsManager and thank you for your confidence in the TimeTronics products and services. 

 

The editors 

 

 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
© Copyright 2019 TimeTronics. All rights reserved. 
 
TimeTronics BVBA 
Lammerdries-Oost 23b 
B-2250 Olen 
Belgium 
 
Tel.: +32 (0) 14 23 19 11 
 
 
Disclaimer 
Under no circumstances shall TimeTronics be liable for any loss, damage or expense suffered or incurred with respect 
to any defective product. In no event shall TimeTronics be liable for any incidental or consequential damages that you 
may suffer directly or indirectly from use of any product. 
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1. Introduction 

The administration during an athletics meet can rapidly extend to immense proportions. To 

simplify this, a first version of the computer application MeetManager was developed in 1995. 

Meanwhile, that application has been fully rewritten from the ground up, and therefore renamed 

to AthleticsManager, to make athletics administration even faster, handier, and more optimal for 

you, the user. 

 

This manual starts off by listing the different steps you have to carry out to prepare 

AthleticsManager for use in the field. Next, we take a look at preliminary administration, in which 

you will learn how to set up correctly a meet, and how to add events. In the chapter after that, 

you will learn how you can easily add competitors to the meet, and how you can enter event 

results. 

 

To prepare for these tasks, the introduction chapter briefly shows you how AthleticsManager fits 

in between other TimeTronics products, which terms are used in AthleticsManager (and their 

meanings), and to finalize a short overview of the main interface elements. 

1.1 Overview 

AthleticsManager can receive data from other TimeTronics products, like MacFinish. These data 

are first processed, and then saved in AthleticsManager. The data can then be exported or viewed 

on different outputs: csv, html, and in the future on equipment like ScoreBoard or on television 

screens. 

 

Figure 1: Data is being entered in input equipment (left), then processed by AthleticsManager (center) 
and next exported to output equipment (right) 



 

 

2019v1 AthleticsManager manual 

 

      

8 

1.2 Used terminology 

It is very important to agree on a uniform terminology when processing large quantities of data. 

The figure should provide an explanation of which terms AthleticsManager uses internally, and 

how these relate to each other. The table below should provide clarity on the used terms. 

 

English Description 

Meet Collection of events. 

Event Part of a meet in which competitors can participate. 

Combined events Collection of track and field events. 

Heat 
Collection of participants that compete to each other in 1 heat, e.g. to divide 

participants over an event with limited lanes. 

Group 
Collection of participants that compete to one another in 1 group, e.g. to divide 

participants over a field event with limited places OR Collection of teams. 

Club Organization of athletes OR grouping of athletes from 1 region. 

Team Collection of athletes competing in this meet, often based on clubs. 

Session Purely logical grouping of events, for easier event management. 

Category 
Classification of an athlete OR classification of a participation OR classification-

restriction of an event. 

Table 1: Used terminology – description 

 

1.3 Scope of the application 

AthleticsManager is all about the management of a single meet, through manipulation of its 

events, and subdivision in sessions, categories, heats and teams. The rectangle with the bold 

blue border in figure shows which athletics elements are managed in AthleticsManager. 
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Figure 2: Terminology and structure in AthleticsManager 

 

1.4 Overview of the interface elements 

The interface of AthleticsManager consists of 5 main interface elements: the superuser bar, the 

athlete’s panel, the events panel, the team’s panel and the events manager. 

 

Figure 3: Elements of the AthleticsManager interface 
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Attention: The interface might be set up differently on your system, but all the displayed 

interface elements are present. 

 

1.5 Printing settings 

Throughout the application are buttons to print the corresponding list (usually next to or below 

the button). You can print through the menu File > Print, or by clicking on the different print 

icons in the different panels. A special printing dialogue opens with a list of settings specifically 

for AthleticsManager. Depending on the content that is to be printed and your print order, the 

listed settings will vary. 

 

Figure 4: Example of a printing dialogue 

 

• Template 

The printing template that you wish to use for this print. You can create print 

templates yourself if you have background knowledge of AthleticsManager and 

LibreOffice. We have hidden this function behind a password to avoid mistakes. If 

you are interested in this option please send a contact request to 

info@timetronics.be If you have a license which is part of a national purchase 

organised by your federation please contact your federation helpdesk. Enable 

Show all templates to display all installed printing templates, not just the 

compatible ones. 

 

• Settings – Round 

Select the round you wish to print, or <all> for all of them. 

 

• Settings – Heat 

Select the heat you wish to print, or <all> for all of them. 

 

• Settings – Session 

Select the session you wish to print, or <all> for all of them. 

mailto:info@timetronics.be
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• Settings – Sort by 

Select the field by which you would like to sort. This function is only visible if you 

give the print order through the menu File > Print. If you print by using the print 

icons in the different windows, you will not have this possibility. 

 

• Save to this file 

The location where the printing file will be saved. During printing, the data will be 

filled in at the correct fields in the print template, which results in a new file. This 

file will be saved on the location you indicate here. ADVANTAGE; If desired, you 

can use this “Opendoc” file to make late changes to the layout, by adding or 

removing or changing some elements, before you send this file to the printer. Just 

open the file in Openoffice or Libreoffice, make the changes, and print the modified 

file. 

 

• Printer 

A list of the selected printers to which you would like to send the print order. Use 

the buttons on the right side above the list to add or remove printers. You can set 

the number of copies as well. 

 

 

---------------------------------------- 
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2. AthleticsManager Setup 

A few simple installation steps have to be followed to get AthleticsManager ready for use. After 

that, the application needs a connection with an AthleticsManager database, by which the user 

profiles have to be set correctly (in the database). 

2.1 System requirements 

Minimum specifications: 

Operating system Windows XP SP3 or later* 

CPU Single Core (1 GHz) 

Memory 512 MB RAM 

Disk space 16 GB 

Screen size 15,4” (800 x 600 px) 

 

Recommended specifications: 

Operating system Windows XP SP3 or later* 

CPU Dual Core (2 GHz) 

Memory 2 GB RAM (800 MHz) 

Disk space 100 GB SATA (7200 rpm) 

Screen size 15,4” (1280 x 1024 px) 

 

Ideal specifications: 

Operating system Windows 7 (Professional or Ultimate)* 

CPU Quad Core (2,4 GHz) 

Memory 4 GB DDR3 RAM (1333 MHz) 

Disk space 100 GB SSD 

Screen size 17” (1280 x 1024 px) 

 

* AthleticsManager is a 32-bits application, but works also on a 64-bits platform. 

 

2.2 AthleticsManager installer  

2.2.1 Installer 

We have 2 types of installers, a standard version which includes all components and a LITE 

version 
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AthleticsManager installer contains: 

• AthleticsManager Server 

• AthleticsManager Client 

• AthleticsManager PostgresSQL Database Engine 

• LibreOffice 

• XML Creator 

• Serial to MacFinish 6.x 

 

AthleticsManager installer LITE contains: 

• AthleticsManager Server 

• AthleticsManager Client 

• AthelticsManager PostgresSQL Database Engine 

 

A window opens up, where you can choose which parts you wish to install. For further detailed 

information please jump to paragraph 2.2.2 

 

 

Figure 5: Installation overview window 

 

Note: Neither PostgreSQL nor LibreOffice are products of TimeTronics. We are not responsible 

for any internal problems that might arise due to PostgreSQL or LibreOffice. 
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2.2.2 Options of the AthleticsManager Installer 

2.2.2.1 Choose Install Language 

2.2.2.2 Prerequisites 

LibreOffice will be installed when you check this box. AthleticsManager 

needs LibreOffice for printing services. 

2.2.2.3 Choose which products to install 

2.2.2.3.1 AthleticsManager server 

If you plan on using the server-client functionality, you will 

need the AthleticsManager Server. Just one computer in the 

network needs an AthleticsManager Server. By selecting this 

option, you also automatically mark the PostgreSQL database 

software for installation. 

2.2.2.3.2 AthleticsManager client 

The AthleticsManager Client can be installed on multiple 

computers. They need to be in the same local network as the 

AthleticsManager Server, please mark LibreOffice for 

installation. 

2.2.2.4 Choose the extra features to install 

2.2.2.4.1 XML Creator 

Please note that this feature is not available in the LITE 

version. 

 

XML Creator will allow you to build your own feeds. All 

information is send through this feature in a structured way. 

Please note that this option is for more advanced users only. 

2.2.2.4.2 Serial to MacFinish 6.x 

Please note that this feature is not available in the LITE version 

 

If you use MacFinish 6.x software you can exchange 

information with AthleticsManager (results and start list) using 

this feature. Please note that MacFinish 7.x and 8.x are using 



 

 

2019v1 AthleticsManager manual 

 

      

15 

a network connection for a link to AthleticsManager, and 

therefore do NOT need this option. 

 

2.2.3 Installation Windows for AthleticsManager server 
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2.2.4 Installation Windows for AthleticsManager client 
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2.2.5 Installation Windows for AthleticsManager XML Creator 

Please note that this feature is not available in the LITE version. 
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2.2.6 Installation Windows for AthleticsManager to MacFinish 6.x Serial 

Please note that this feature is not available in the LITE version. 

 

  
 

  
 

 
 

2.3 Database 

A correct database is automatically loaded in the database service after installation of the server. 

If you wish to use the server-client environment, be sure the server’s database service is running 

when starting the AthleticsManager Client. Starting or stopping the database service can be done 

through the appropriate button in the AthleticsManager Server (as administrator). 

 

Note: The database can be emptied using an AthleticsManager Client, through the menu item 

Clear in the menu File. You need to be logged in as a user (profile) with sufficient privileges for 

this though (e.g. superuser). 
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2.4 Firewall 

When you use a client – server setup you have to configure your firewall. 

 

Clients have to authenticate to the server first, and are only then able to communicate with the 

database of the PostgreSQL server. 

 

If you are using the default Windows Firewall, you will receive a notification at the first start of 

one of the applications (client or server). Simply click on Allow access, and the correct firewall 

rules will be added to Windows Firewall. 

 

The same principle will probably apply for other firewall software. If no message requesting 

access appears, you will need to enter the correct firewall rules manually. To do this, please 

refer to your firewall software’s manual. 

 

The required firewall rules for correct functionality of AthleticsManager are listed the table here 

below. The rules in italic are defaults on most firewalls and will probably not need to be set 

explicitly. 

 

Application 

 

Protocol / Port 

 

Direction 

 

AthleticsManager Server UDP/1217 In 

AthleticsManager Client UDP/1218 In 

PostgreSQL TCP/5432 In 

AthleticsManager Server */* Out 

AthleticsManager Client */* Out 

PostgreSQL */* Out 

Table 2: Required firewall rules for AthleticsManager. 

 
The installer of AthleticsManager server will execute a batch file to include the PostgreSQL 

database application to the incoming Windows firewall rules. The file is also available in the 

installation folder (postgres_firewall_rule.bat). 
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2.5 Client / Server environment 

The server application coordinates the traffic between the clients and the database. Multiple 

clients (both AthleticsManager Client and for example MacFinish) communicate with the 

AthleticsManager Server for exchanging data. This communication happens over a local area 

network. If all clients and the server are present on one system, a local area network is not 

required, as all the pieces of software communicate over the loopback interface (IP 127.0.0.1). 

 

 
 

Figure 6: Client / Server environment 

 

The status of the database service is displayed in the AthleticsManager Server interface. When 

active, the AthleticsManager database can be backed up and restored quickly and easily (file 

format .amb). You can also automatically zip this backup database or load a zipped database 

direct into the AthleticsManager Server. The zipped .amb file takes only approx. 10% of the 

standard .amb files 

 

By minimizing the AthleticsManager Server window, it will remain active in the system tray. 

 

Because the server application manages the back-end database, this application needs 

administrator privileges. This should be set up correctly during installation, but if this is not the 
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case, you can change this very easily: right-click an AthleticsManager Server shortcut (like one 

on your desktop), and select Properties from the context menu. The properties window 

appears. Click on the Advanced-button and check Run as administrator. Press OK in all 

windows you have opened. 

 

The client application works by simply choosing a server or a local database from the combo 

box. Update this list by pressing [F5]. Running multiple clients is possible, up to a maximum 

that your license key allows. These can then communicate with the server over a local area 

network. 

 

2.6 Uninstall 

You can use ‘Windows’ default program management utility available in the control panel. You 

have to search for the following programs: 

• AthleticsManager Server 

• AthleticsManager Client 

• AthleticsManager PostgresSQL Database Engine 

 

---------------------------------------- 
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3. AthleticsManager general info 

On your desktop you will find now different icons depending on the options you have chosen to 

install. 

 
 

3.1 AthleticsManager Server 

3.1.1 Start AthleticsManager server 

Click on the following icon to start the server: 

 

 

 

The first initialization will take several minutes, you will see different messages. 

 

 

 

 

 

 

 

3.1.2 Name of AthleticsManager server 

Here you can change the name of your server. Later you will need this name to see to which 

server you want to connect with the client. 
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3.1.3 License code 

If you connect a valid dongle (=USB-license key) to your computer or type the correct license 

number in case of federation contract then the “Licensecode” field will be shown in white color. 

 

 

 

3.1.4 Database engine 

By clicking on the info button next at the database engine row, you will get an overview of the 

active database engine sessions. 

 

The window gives you an overview of all active connections to the database. 
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3.1.5 Web service 

By clicking on the info button next at the web service row, you will get an overview of the active 

web service sessions. 

 

 

 
When a client wants to make use of the web service of the server, it needs to make a connection 

to the web service. First the client needs to find the server. It will send a search request on the 
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network. The server shall handle this request by first checking if your registration license is 

allowed to make a connection to this client. If it is allowed, it shall then answer the client with 

an encrypted message. 

 

From this point the client knows the ip address of the server and can make an HTTP request to 

the webserver. It therefore will create a session ID with the servers ip address, username, 

password (encrypted ofcourse) and GUID. The session ID is then added in the header of the 

HTTP request and sent. All this is done automatically. A user simply has to wait until the client 

has detected the server to start. 

 

The web service will receive the HTTP request and check if the session ID is valid. Afterwards it 

shall post the answer to the client. Checking for a valid session ID means decrypting the 

username and password of the request and comparing them. All new valid sessions will be stored 

in the active sessions table of the web service status window. 

 

As described before the webservice runs on port 8090. A client can interact with the web service 

by initiating a request on http://servername or ip address:8090/ 

 

Handled get requests of the web service 

• competitions (get all competitions) 

• events/competition_id (get all events from a specific competition) 

• participations/heat_id (get all participant from a specific heat of an event) 

• results/heat_id (get results from a specific heat) 

• ahletes (get athlete based on offset or search value) 

• fieldtablet/action (get info of field tablet app. Action can be version, size, hash or 

download) 

• whatishappening (get entries of live events) 

 

 
Handled post request of the web service 

• update_participation (update the participation table and others) 

• new_result (add new result to the results table) 

• update_result (update result of the results table) 

• delete_result (delete result from the results table) 

• new_whatishappening (insert new entry in the whatishappening table) 

 
For each of these post types a list of parameters can be appended. This is not documented as it 

would take us to far. 
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This window has some extra functionality to clear an active session or to block connections from 

a specific ip address (in case somebody is harassing you).   

 

3.1.6 Advanced 

If you click on “advanced” some new options will be shown. You can choose between the different 

national federations or if your federation is not listed, choose others in the layout 

dropdown list. In this case most  common used IAAF setting will be used. 

 

 

 

3.1.6.1 Automatic backup 

You can select to automatically backup the database. You can specify the 

interval time, the number of backups you want to be stored on the hard 

disk and the location of the backup. 

 

3.1.6.2 Proxy 

If a customer wants to use his own network to run AthleticsManager on, 

it is plausible that he uses a proxy server for security reasons. In this case 

you can set the name or ip address of the proxy server and its port 

number so AtheleticsManager can reach online sources to update his 

(local) database. 
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3.1.6.3 Database 

The last option to set in the advanced window is the location of the 

Postgres database. In 99.99 % of the cases you should not mess with 

this. 

3.1.7 Database actions 

 

 

3.1.7.1 Make a backup of current meet 

Using the AthleticsManager Server, you can make backups of the meet’s 

database. These backups can then later be restored in this or another 

AthleticsManager Server. 

 

The Undo-button (the one with the turning arrow), restores the database 

to the status just before the last restored database. So, if you were using 

My competition v1.amb first, and then restore My competition 

v2.amb, possibly make some changes, and press the Undo-button, the 

database will be back to right before you loaded My competition 

v2.amb, so the database will contain My competition v1.amb again. 

 

3.1.7.2 Load an earlier copy of a meet 

With this functionality you can load the backup meet database of the 

previous step 
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3.1.7.3 Load a model competition 

3.1.7.3.1 Load a model competition (with server layout 

“federation” 

You will get a choice of model competitions which are specially 

defined by/for your federation. Please choose the right 

competition you want to prepare. 

 

3.1.7.3.2 Load a model competition (with server layout 

“others”) 

To start a new competition, you have to load a model 

competition. The list of model competition you can choose 

from is depending on the “Layout” you have selected under 

advanced. If you have chosen general than you will get 2 

options. 

 

 

 

You can choose International meet in case you do not IPC 

(Paralympics). You will get a warning message. If you want to 

start a new meet you can click yes. If not, please make first a 

backup of your meeting before continuing. 
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It will take a few minutes to install the model competition so 

please be patient till you get following message. (You will not 

have any progression feedback) 

 

 

 

Be sure that you click on ok before continuing otherwise you 

will not have the right settings in your client afterwards 

 

3.2 AthleticsManager client 

3.2.1 Start AthleticsManager client 

Click on the following icon to start the AM Client: 

 

 

 
Choose the server to which your client has to connect. 
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3.2.2 User Profile 

A user profile is a combination of a user (name), a password, and a collection of user privileges 

to certain parts of functionality in an AthleticsManager Client. When logging into a database, you 

need to provide the client with valid user login credentials. By default, three users exist: 

 

User name Default password User privileges (description) 

superuser superuser All privileges, can do anything. 

advanced user advanced Can manage the meet, but cannot change any global settings. 

 

beginner user 
 

 

Can only change results. 

Table 3: Description of user profiles. 

 
These three user profiles are always available and cannot be removed. The password of the 

logged in user can be modified through the info-window in the menu Help > About. It is 

recommended to change all default passwords. Profiles and their passwords are saved when 

making a backup. 

 

The superuser can add new and modify existing user profiles through the Users-window. More 

info about this can be found in the chapter 7.6 User profiles. 

 

 

 

 

3.2.3 Advanced 

If you click on advanced, you will see info at the print path. This means that all your settings are 

ok to print from the Client. If you see an empty field please go to the complete manual to get 

this setting properly done. 
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When installing the client, you are presented the option to install LibreOffice. This is a free word 

processing software that which is used for printing documents. The client will automatically find 

the location of the software (e.g. LibreOffice or OpenOffice) and set it in the print command text 

field. 

 
Print command: "C:\Program Files\OpenOffice.org 3\program\soffice.exe" 

-pt "%2" "%1" 

parameter 1: file name 

parameter 2: printer name (retrieved by calling printer dialog) 

 

You can set a new print command, if you want to use a different word processing software. We 

do not advice this. 

 

The advanced login settings for the database are currently not used. 

 

 
 

If you click on ok you will see the standard startup screen of the AthleticsManager Client. 

 

3.2.4 Modifying interface 

The interface of the client can be modified considerably, by moving around panels. By 'panel', 

we mean: a group of interface elements that are on one interface plane. Examples are the 

athlete’s panel, the team’s panel, etc. A panel can be moved around (by dragging its title bar) 

and scaled (by dragging the borders of a panel). Panels can also be grouped together, by moving 

them over each other. To switch grouped panels, simply switch between their tabs (below). To 

split them, you just have to drag a panel to another location. 

 



 

 

2019v1 AthleticsManager manual 

 

      

32 

Panels can be hidden and shown through the menu Window > Panels and enabling (show) or 

disabling (hide) a panel. The events manager and superuser bar are exceptions to this rule. The 

events manager is always visible (it takes up the leftover space), and the superuser bar can only 

be made visible by right-clicking on the menu bar and clicking Superuser. It can be hidden the 

same way. 

 

There are different kinds of panels, each with their function and own way to move around: 

• Most panels can be moved around by dragging the title bar of the panel, and dragging 

the panel to a desired location in the interface. 

 

• The superuser bar is a special panel that can be moved by holding it on the left-hand side 

and then dragging it. This panel can be placed everywhere in the application, but we 

recommend you to place it on top or at the bottom of the application. 

 

• The events manager is a panel that automatically adapts itself to fit in the leftover space 

not used by the other panels. As a result, it cannot directly be moved around. 

 

 

Figure 7: Possible point for dragging the athlete’s panel. 

 

 

Figure 8: Possible locations of a 'regular' panel (blue and green). 
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Figure 9: Dragging the superuser bar. 

 

 

 

Figure 10: Possible location of the events manager. 

 

Another possibility of modifying the look of the user-interface is by hiding/showing certain 

columns. AthleticsManager is host to a lot of tables, which might cause a bit of a visual data 

overflow. If that is the case, you can right-click the header of a column, and choose which 

columns you want to have shown (checked) or hidden (unchecked). 

 

 

Figure 11: Possible columns in the Start lists-tab. 

 

 

---------------------------------------- 
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4. AthleticsManager Preliminary administration 

Before you start entering results, a lot of properties need to be set. When using model meets, 

these properties should be correctly set in advance. No harm on checking up though. 

 

The meet properties are specific options for your meet. One of the tabs in the meet properties 

are the default properties for events. The options set here are copied as settings for NEWLY 

added events (not existing ones!). After all events have been added, and have the correct 

properties, you may start processing the registrations. Add athletes, in teams or not, as 

participant for one or more events. 

 

4.1 Competition properties 

We define a meet as a collection of events over a specific time span. This is used as a starting 

point for athletics administration. The meet properties window can be opened by clicking left 

top: File – Meeting General Properties. You may find it in the events panel, next to the name of 

the meet, recognizable by a pencil icon. A new window with 6 tabs appears. 

 

4.1.1 General 

The tab General contains a list of general properties. 

 

 

Figure 12: Meeting General Properties 

 

• Name 

The name of the meet. (Required) 
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• Federation 

The federation that hosts this meet. (Required) 

 

• Country 

The country that hosts this meet. (Required) 

 

• Place 

The place that hosts this meet. (Required) 

 

• Code 

An identifier code for this meet, for example the federation’s unique ID for this meet, or 

an international ID code. 

 

• Type of location 

Define if this is an Outdoor, Indoor or Outside of stadium meet. 

 

• Dates 

The starting and ending dates of the meet. The input format depends on your system’s 

locale. By clicking on the arrow on the right side, a pop-up calendar appears that aids 

you in easily selecting a date. It is very important that you set the correct dates, for the 

reference date can calculate the age categories with the correct dates. (Required) 

 

• Reference date 

Calculates the age categories of the athletes, based on the dates of the meet. 

 

• Info 

Extra information you wish to save, like a description of the meet. 

 

• Header image 

Add an image to be printed in the header. By double-clicking with the left mouse button 

in the grey zone, you can browse your pc and select the image. To remove the image, 

double- click with the right mouse button in the grey zone. 

 

• Footer image 

Add an image to be printed in the footer. By double-clicking with the left mouse button 

in the grey zone, you can browse your pc and select the image. To remove the image, 

double- click with the right mouse button in the grey zone. 
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4.1.2 Sessions 

For big meets, it is a pain to search a single event in the list of all the events of all days and all 

categories. That is why the concept of sessions was introduced in AthleticsManager. Essentially, 

sessions are nothing more than logical subdivisions of the events of a meet. They have no 

influence whatsoever on the point calculation. 

 

Some examples on how you can classify events into sessions: 

• A meet for men and women, can be classified into two sessions: Men and Women. 

• A meet that lasts two days, can be classified into two sessions: Competition Day 1 and 

Competition Day 2. 

• A meet for two categories (e.g. Masters and Juniors), can be classified into two sessions: 

Masters and Juniors 

• A meet that lasts two days, for two categories (ex. Masters and Juniors), and divided by 

gender (men and women), can be classified into eight sessions: MM-D1, MM-D2, MW-

D1, MW-D2, JM-D1, JM-D2, JW-D1 and JW-D2 (Masters Men – Day 1 / Juniors 

Women – Day 2). 

 

The way you wish (or do not wish) to use sessions, is entirely up to you. The model meets 

already have some sessions sets, which we think will be the most useful for the average user 

experience and for that meet. 

 

 

Figure 13: Modifying the sessions of an event 
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• Sessions 

A list of sessions for this meet. You can add and remove sessions using the buttons below 

the list. 

 

• Session info – Name 

The name of the selected session. Do not leave this empty! (Required) 

 

• Session info – Date 

The date when this session is to start. This can be useful for meets that last multiple 

days, and you wish to subdivide the meet into sessions by day. It is this value that will 

be used in the printing templates. (Required) 

 

• Session info – Time 

The time when this session is to start. This can be useful to subdivide the meet into the 

morning, the afternoon, the evening, ... (Required) 

 
Note: Keep an eye out that there are no sessions with an 'empty' name in your session list. You 

may recognize them by trying to click the entry right below your lowest session. If an empty 

field gets selected, remove it. Empty vertical spaces between sessions also indicate empty-

named sessions. Although empty-named sessions work just fine, they may be confusing in your 

interface. 

 

4.1.3 Call rooms 

An optional, for now purely administrative function in AthleticsManager, is the use of call rooms. 

Before an event officially starts, an athlete can report to a call room. In future versions of 

AthleticsManager, this data can probably be exported to an external display device, like a screen, 

so competitors know where to report. 
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Figure 14: Example of call rooms 

 
• Call rooms 

A list of call rooms for this meet. You can add and delete call rooms by using the buttons 

at the bottom. 

 

• Call room info – Name 

The name of the concerning call room. (Required) 

 

4.1.4 Teams 

Here you make the teams, for meets in teams. There are some guidelines that have to be taking 

into account, to simplify the later processing. 

 

A group is a collection of teams. Groups are, just as sessions, a purely logical category, but this 

time of teams instead of events. Every team that you create, must have a group to associate 

with. If you do not want to use separate groups, you can use a default name for the group (for 

example an empty name) and work with this. 

 

A team is not the same as a club. One club can send multiple teams to a meet. Therefore, it is 

important to add in the group name a category and possibly even an increasing team number. 

This will be comprehensible through the examples. A final important option to note are the 

standard categories. These are used in two ways: a correct listing of possible events where an 

athlete can participate in, and an automatic team assignment of an athlete according to the club 

and category. This is explained in the note underneath subsection 4.3.4 Enrol an athlete into an 

event. 
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Figure 15: Change teams in a meet 

 
• Groups 

A list of groups for this meet. You can add and delete groups by using the buttons at the 

bottom. 

 

• Number of points (in correct order) 

The number of points that the teams get assigned, according to place, starting from the 

first place, and separated by semicolons. Example: 12;11;10;9;8. 

 

• In case of a tie take 

If there is a tie, is it the maximum or the average of the points associated with these 

places that has to be used? Example: two teams both have the second place, will then 

either 11 (maximum) or 10,5 (average) points be used. 

 

• Teams 

A list of teams for this meet. You can add or delete teams by using the buttons at the 

bottom. 

 

• Team info – Name 

The name of the concerning team. 

 

• Team info – Abbreviation 

The abbreviation that is given to this team. 
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• Team info – Info 

Extra field where you can add information about the team, for example a definition of the 

team. 

 

• Team info – Code 

Identification code for for example heat classification. This is used to pass parameters to 

methods that require these. 

 

• Team info – Group 

The group where this team belongs to. 

 

• Team info – Default club 

The club from where the team is sent. If the Name-field matches with another club, then 

this club will automatically be selected. 

 

• Team info – Default categories 

The categories that the members of this team should have. Do not forget to click on the 

plus-button after selecting a category. For several examples of entering the categories, 

see Appendix B. 

 

4.1.5 Default settings 

The values in the tab Default settings are used as predefined properties when adding new 

events. They have no effect on existing events! In other words, the values that you set here will 

be copied to the properties of new events, but not to the existing events. 

 

These default properties are extensively discussed in section 4.2 Competition events. 
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Figure 16: Default settings for new events 

 

4.1.6 Advanced 

The tab Advanced contains some various options that are applicable to the meet. 

 

 

Figure 17: Advanced settings of the meet 

 

 

• Maximal number of participants for each team – in whole competition 

Limiting value for the number of team members who can participate in the meet. (0 for 

infinite) 

 

• Maximal number of participants for each team – in only one event 

Limiting value for the number of team members who can participate in one (single) event. 

(0 for infinite) 
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• Maximal number of events for each participant 

Limiting value for the number of events in which one participant can take part. (0 for 

infinite) 

 

• Default print format for the participant name 

When adding athletes as participants, their displayed name is adjusted to this size (for 

print-outs etc). Click on the buttons to switch between variables. Use the text fields to 

modify the separations (space, commas etc). 

 

4.2 Competition events 

A meet consists of multiple events. With events, there is a difference between a 'single event' 

(for example multiple rounds) and 'combined events', consisting of multiple events (where the 

rounds are individual events). The figure here below shows how this works internally in 

AthleticsManager. This is to let the database function more optimally. 

 

 

Figure 18: List of events in the Events panel 

 
You can find the events of the meet in the events panel, which is always present in the interface. 

The buttons on the left-hand side in the events panel are used to modify the events. Their 

functions should speak for themselves: New event, Event properties, Open event (in the 

event administrator), Delete event, Print list of events. Next to this you also have the 

meet buttons, which we have already discussed in a previous chapter. 
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The table that stands underneath this, consists a lot of columns. An explanation: 

 

• Nr 

An administrative number of the event. This number is an administrative help for anyone 

who is involved with the administration of the meet. 

 

On the right side of the window, next to the refresh button, there is a button that will indicate if 

a round or heat can possibly be set official. AM will inspect all events that are not set official and 

notify the AM operator if any results were received. The button will be green if all events that 

have results are set official. The button will be red if there is an event that has results that is 

not yet set official. 

 

This feature can be handy for track events when working with MacFinish. If MacFinish has send 

its results to the AM Server, the AM Client operator will be notified by this button that the race 

is finished. 

 

Note: The set official button can only be used for track events. 

 

• Name 

The Name-field contains the name of the event. For a single event with multiple rounds, 

the round name stands between brackets. For combined events, the event name stands 

between brackets. 

 

• Event time planned 

The time when this event or this round is scheduled. 

 

• Official 

The time when this event or round is made official. 
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• Session 

The session to which this event belongs. 

 

• Event 

The event to which this round belongs OR the combined events to which this event 

belongs. 

 

• Number of participants 

The number of participants that is registered for this event or this round. 

 

• Number of heats 

The number of heats for track events or the amount of groups for field events, into which 

this event or this round is divided. 

 

• Background colour 

The background colour of a row symbolizes the status of the event or the round. 

o White  : Waiting for participants. 

o Grey   : Waiting for results. 

o Light blue : Event has started. 

o Yellow  : Results are available. 

o Green  : Results are official. 

o Red   : Results are corrected after making official. 

 

Note: When all sessions are shown, and you have sorted by Event time planned, then first the 

date and time of the sessions are considered, and secondly the time of Event time planned. 

 

4.2.1 General 

When you add a new event, or you modify an existing event, a window with two tab pages will 

open: The event properties. This window consists of two tab pages: General and Rounds. The 

General-tab applies for all types of events and contains general settings for this event. 
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Figure 19: General properties of an event 

 

• Name 

The name of the event. (Required) 

 

• Abbreviation 

The abbreviation of the event. 

 

• Info 

An info field for the event. This field can contain for example a definition of the event. 

 

• Type 

The event type. This list contains all event types that are determined in section 7.1 Event 

types. (Required) 

 

• Categories 

The categories which this event is meant for. This way incorrect participations can be 

noticed more quickly. When no categories are listed, then all the categories are permitted. 

Use the check boxes on the left of the combo box to filter the listed categories. 

 

Note: The check boxes Show all for both Type as Categories show or hide extra choices in the 

combo box next to it. 
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4.2.2 Rounds 

With combined events this tab page contains a list of the combined events. In the other case 

you will find here a list of the rounds of a “normal” event. By default, one round is created by 

the software: with the default name “*”. This is useful for meets of which the events contains 

no rounds. Note; The name “*” will never be printed on a participant or result sheet. Any other 

round name will be printed, if used in the print layout. If you would like to change the number 

of rounds or the name of the round(s), you can add, delete and reorder the rounds here, by 

using the buttons at the bottom of the list. For EACH round you can separately modify a lot of 

properties (Details). 

 

 

Figure 20: Modifying the round properties of an event 

 

• General – Name 

The name of the round. (Required) 

 

• General – Abbreviation 

The abbreviation of the round. With combined events, the abbreviation is used as the 

heading of the results table. 

 

• General – Info 

An info field for the round. This field can for example contain a definition of the round, or 

the starting height of a high-jump competition. 

 

• General – Session 

The session that belongs to this round. This list is filled with sessions defined in subsection 

4.1.2 Sessions. (Required) 
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• General – Start time 

The start time of this round. This value is shown in the list of events in the events panel. 

 

• Teams – Maximal number of participants for each team 

Limiting value for the number of team members that is allowed to participate in this 

event. 

 

• Teams – Number of participants for point calculation 

Limiting value for the number of team members of whom the points will count as team 

points. In other words: the points of the -n- highest scoring (according to place and 

result) participants from the same team count for team points. 

 

• Teams – Method for point calculation 

The method how the team points are calculated. There are two possible methods by 

default. This list can be expanded by the personal methods of your federation. 

 

o On place: 

Team points are assigned according to the values in the field Amount of points in 

order and the chosen option for In case of a tie take, on the tab page Teams of 

the meet properties (see 4.1.4 Teams). 

 

o On performance: 

Team points are assigned according to the individual points, based on the 

performance. The possible correction factors are hereby also considered. 

 

o <not assigned>: 

No team points will be assigned, in other words, team points are not in effect here. 

 

• Field event – Start height (depending on event type) 

The start height of high jump-events. This function is only visible for vertical length 

events. Format: 0.00m. 

 

• Field event – Interval (depending on event type) 

The default value for the interval of sequential heights. This function is only visible for 

vertical length events. Format: 0.cm. 
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• Field event – Number of attempts (depending on event type) 

The number of attempts that can be done for this event. This function is only visible for 

events with multiple attempts. 

 

• Heat composition – Number of places 

The number of available places in a heat or group. This is used for automatic heat or 

group composition. 

 

• Heat composition – Used lanes (only events that make use of lanes) 

Only the selected lanes are used in the heat composition. Click to use (red) or to not use 

(grey) a lane. 

 

• Heat composition – Method 

The way how the composition will be executed. There are two possible methods by 

default. This list can be expanded by the personal methods of your federation. 

 

• Heat composition – Parameter 

A possible parameter that can be included in the heat composition method. 

 

• Heat composition – Time for each heat 

An estimated duration per heat. With this the start time of every heat is automatically 

adjusted to the time of the last added heat, increased by the duration that is entered. 

For the first added heat, the start time of the round is used. 

 

• Qualification – Method 

The way how the qualifications can be calculated by the AMsoftware. There is one possible 

method by default. This list can be expanded by the personal methods of your federation. 

o [On place];[on time]; 

 

o <not assigned> 

First on place, then on time. The given parameters for this method are the number 

of participations that are qualified on place, and next the number on time, 

separated by a semicolon ( ; ). 

 

• Qualification – Parameter 

A parameter that has to be given with the chosen qualification method mentioned above. 

For example: 2;3. In this case, every 1st and 2nd athlete of each heat will be qualified, as 
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well as 3 other athletes that have the fastest time over all heats. This parameter is used 

for track events. 

 

• Point calculation – Method 

The method for (individual) point calculation. There are four possible methods by default. 

This list can be expanded by the personal methods of your federation. 

o IPC; 

o IAAF RACE; 

o IAAF JUMP; 

o IAAF THROW; 

o <not assigned> 

 

• Point calculation – Apply correction factor for following categories 

A list of the categories for which a correction factor should be applied to the performance, 

which will then be processed by the point calculation formula to form the total amount of 

points. The role of the correction factor in the point calculation formula is explained in 

subsection 6.2.1 Individual points. 

 

4.3 Participations 

In this section it is important to make a difference between an athlete, a participant and a 

participation 

 

• An athlete is the person as he/she is stored in the database. 

• A participant is an athlete who takes part in the meet. 

• A participation is a link between the participant(s) and an event of the meet. 

o Usually this is a single participation, so a participation is 1 participant 

o In case of relays this is a multiple participation, for example 4 participants is 1 

participation. 

 

Also the difference between a category of an athlete, team, event and participation is important. 

Depending on the event type, check-ups happen based on either the date of birth, or the year 

of birth. 

 

• The category of an athlete depends on his/her age. 

• The category of a team is adjustable per team and is especially for automatic addition of 

athletes as members. 
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• The category of an event is adjustable per event and makes sure that participants can 

only participate under certain categories. Only for the permitted categories (in other 

words the categories of an event), points are calculated. 

• The category of a participation (below referred to as 'participation category') is the 

category that is used to process the participation in an event. 

 

With this terminology in mind, you can get started with participation administration. 

 

4.3.1 Creating athletes 

You can create new athletes in the athlete’s panel. On top of the panel you see different buttons 

to create or modify athletes. The plus-button on the left-hand side can be used to create new 

athletes. If you click hereupon, you will open a new window with three tabs: General, This 

competition and Personal bests. 

 

The General-tab contains three parts: General, Licenses and License details. 

 

 

Figure 21: Tab New athlete – General 

 

• General – First name / Middle name / Name 

The first name, possible middle name(s) and last name of the athlete. 

 

• General – Gender  
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The gender of the athlete. 

 

• General – Nationality  

The nationality of the athlete. 

 

• General – Date of birth  

The date of birth of the athlete. 

 

Licenses This field shows you the licenses of this athlete. To add a license, you first have to fill 

in the license details in the License details-part, after which you click on the plus-button under 

the licenses field. To delete any licenses, select the license in question and click on the trash- 

button. 

 

• License details – Start date / End date 

The start date and end date of the athlete's license. 

 

• License details – Federation / Team 

The federation and team to which the athlete belongs. 

 

• License details – License number 

The license number of the subscription to the federation. This is thus the license number 

that was assigned during the subscription. 

 

• License details – Start ID 

The fixed start ID that belongs to the subscription of the federation in question. This is 

thus the start ID that was assigned during the subscription. 

 

• License details – Category 

The category that belongs to the athlete. This category is calculated based on the 

athlete's date of birth. 

 

The second tab is the This competition-tab and contains one button: Add <name> to current 

meeting, where <name> is of course the name of the concerning athlete. If you add the athlete 

to the current meeting (by clicking on the button), the tab will show your more information, 

existing of two parts: General and Participations. 
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Figure 22: Tab add athlete in current meeting 

 
On top of the tab you have the possibility to remove the athlete from the current meeting. 

 

• General – License 

The license under which the athlete will participate in the meeting/event. 

 

• General – Name 

The name of the athlete. 

 

• General – Start ID 

This is the start ID that you can assign yourself. This can be a different number than the 

standard number that was assigned by the federation during the subscription (and which 

you entered in the previous tab). 

 

• General – Team 

The athlete's team. 
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• Participations 

In this part you will see the events in which you would like the participant to participate. 

If you check the Show all events-check box, all events will be listed in order to select 

manually the events to participate in. 

 

• Personal best 

Contains one part: Performance. In this tab you can enter the best performance per event 

(of the season / of the entire career). This performance will also be shown in the list of 

possible events in the This competition-tab. 

 

 
Figure 23: Tab New Athlete – Personal Bests 

 
• Performance – Event 

The event for which you want to enter the best performance. 

 

• Performance – Performance 

The result of the best performance. 

 

• Performance – Wind 

If the wind could have influenced the performance, you can enter the wind velocity (by 

means of a wind measurement) here. 
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• Performance – Date 

The date of this best performance. 

 

• Performance – Seasons best/Alltime best 

Here you can enter whether it was the best performance of the season or of his entire 

career. 

 

• Performance - All best performance button 

By pushing this button, you will get a list of all events to which the participant is 

subscribed. You can then enter all best performances without having to look up the event 

first. 

 

4.3.2 Athlete participation 

Note: If you add an athlete directly as a member of a team, or you register the athlete 

immediately in an event, they automatically become a participant of the meet. The steps 

explained in this section will then occur automatically. 

 

Imagine that you already know which athletes will participate, but you do not know yet in which 

team or in which events, then you can add an athlete to a meet, by following these steps: 

 

• Search in the athlete’s panel for the desired athlete. You can use a quick search for this 

(start typing in the search field) or an advanced search (button with binoculars-icon). 

 

• As soon as you have found the athlete in the list, you open his or her properties. There 

are two ways to do this: 

o Right-click on the concerning athlete and choose Properties, 

o Or select the concerning athlete and then click on the button Modify athlete 

(pencil) on top of the athlete’s panel. 

 

• Go to the tab page This competition. 

 

• Click on the button Add <name> to the current competition, where <name> is of 

course the name of the concerning athlete. 

 

• The athlete is now a participant of the meet 
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4.3.3 Adding an athlete to a team 

It is common that the athletes are registered per club. A club sends one or more teams, by 

means of lists with athletes. Make sure that the teams are created (see 4.1.4 Teams) before 

continuing. 

 
Attention: By teams we do not mean relay teams. These are explained in the next section. 

 
• Open the team’s panel and double-click on a team to open it. 

 

• Choose the identification method to add an athlete: 

o by license number (default), 

o by start ID, 

o or by name. 

 

• Then type in the search field (Search and enter) a search action and push [Tab]. 

 

• Next to the combo box to select the type, there will be a second button, with the first 

search result. You can push once again on [Tab] to show a next search result (for 

example with athletes with the same name — with license numbers, there is normally 

only 1 result). 

 

• Push [Enter] to confirm the current result. 

 
Note: You can also directly push [Enter], without first pushing [Tab]. Then the first search 

result will be added immediately. 

 

4.3.4 Enrol an athlete into an event 

Another possibility to add athletes to a meet, is by directly assigning them to an event. There 

are several methods to do this: 

 

• Double-clicking 

o Open the event in which you want the athlete to participate. 

o Search for the desired athlete in the athlete’s panel. 

o Double-click on the concerning athlete. 

 

• Multiple athletes simultaneously 

o Open the event in which you want the athlete to participate. 

o Select the desired athlete in the athlete’s panel. 
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o Choose at the bottom left in the athletes panel the action Add to current event. 

o Click on the button right next to it to execute the action. 

 

• Typing 

o Open the event in which you want the athlete to participate. 

o Open the Participants tab or the Start lists-tab. 

o In the Start lists-tab you can choose in which round, event, heat or group you 

would like the athlete to participate in 

o Use the search field like in 4.3.3 adding an athlete to a team to add an athlete. 

 

• Checking individual events 

o Add the athlete like a participant of the meet, as described in 4.3.2 Athlete 

participations, in which you check the events in the athlete's properties. 

o In the same tab page (This competition) you can find a list of events at the 

bottom. Check the desired events in the list. 

 
Note: This list is based on the category of the athlete and the category/ies of the team of the 

athlete, no matter whether he is a member or not. 

 

For example: An athlete with the category 'junioren C jongens', is member of the teams with 

the categories 'junioren A jongens', 'junioren B meisjes'. The event list in the athlete properties 

will then contain events with category 'junioren A jongens', 'junioren B meisjes' or 'junioren C 

jongens'. 

 

To deactivate this 'filter', check again Show all events. 

 

Note: If you already created teams, the application will try to assign the athlete automatically 

to the correct team. The application will first check whether there are any teams of which the 

default federation matches with the athlete's federation. If this is the case, the application will 

check the default categories of the team and the category of the athlete. If there is a match, the 

athlete will automatically become member of that team. If there are more matches, the 

application will pick the team that was created first. 

 
Exception – Enrol an athlete into a relay event 

In case of relay events, the participations are relay teams. Each time you enrol an athlete into 

a relay event, a window will pop up in which you can create new relay teams or select existing 

teams. You can enrol an athlete into a relay event by opening the relay event in the events 
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panel, and then adding the athlete (for example by double-clicking the athlete). Then this 

window will pop up. 

 

To create new relay teams, you have to type the desired name and then click New. To pick an 

existing relay team, select the desired relay team in the list and click Select. Next the athlete 

will be added to the relay team in question, in that event. 

 

 

Figure 24: Creating or selecting a relay team 

 

Editing an existing relay team can be done by double-clicking the team in the event in question. 

A window will pop up in which you can edit the name of the relay team, delete its members or 

rearrange the order of the athletes. Cursive names with a grey font are the reserves and will not 

be counted in the teampoints calculation. Removing a relay team is the same procedure as in 

an ordinary participation: select and push [Delete]. 

 

 

Figure 25: Modifying a relay team 

 

4.3.5 Editing participation categories 

As we mentioned in the first part of this section, the participation category is the category of the 

participation (both for an athlete and a relay team) which is taken into account in the point 
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calculation. You will find the participation category in the Participants-tab of an opened event, 

in the Category-column. 

 

When enrolling an athlete into an event, the participation category will be equalized as much as 

possible to the athlete's category. If the athlete's category is not in the list of the permitted 

categories for this event, then the closest next category will be picked. 

 

Example: An event has the following participation categories: 

• Juniors C 

• Juniors D 

A 'junior C' athlete participates as a 'junior C'. 

A 'junior D' athlete participates as a 'junior D'. 

A 'pupil A' athlete participates as a 'junior D' athlete. 

A senior athlete participates as senior (invalid category, no points will be 

calculated). 

 

In the Participants-tab you see the categories in which the athletes participate. The font colour 

shows you the validity of the participation category: 

• White Athlete participates in his own category. 

• Yellow Athlete participates in another (higher age) category. 

• Red Athlete participates in an invalid (lower age) category. 

 

The participation category can always manually be 'overwritten': 

• Right-click on the participation category you would like to modify. 

• Go to the menu Category and select the valid participation category. (The categories 

listed are the categories of the event). 

 

Attention: If a participation category is not accepted (and so marked in red), no points will be 

calculated for that participation. 

 

4.4 Heat composition 

The heat/group composition can be done in the Start lists-tab of an opened event. An automatic 

heat/group composition is based on the options that are set in the properties of an event, the 

round in question more specifically. Just click on the Create Heats-button. If any heats or 

groups have already been created, the application will ask you to overwrite these. 

 

Manually creating or deleting heats/groups can be desirable. This can be done as follows: 
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• Left-click on the round of which you would like to modify the heats/groups. For the events 

without any rounds, this will be an asterisk (*). 

• Click on the plus-button underneath the list to add a heat/group, or at the trash-button 

to delete a heat/group. 

 

You can assign participations to a specific heat/group by selecting the round, right-clicking on 

the participation and then selecting a heat/group in the sub menu Add to heat. This is also 

possible with a selection of multiple participations. 

 

Note: Heat composition is MANDATORY ! Even if you do not want heat/group compositions, we 

recommend you to create always 1 heat or group. This way the application can do its job 

correctly. 

 

4.5 Assigning start ID’s 

You can assign start ID's by using the Assign Start ID's-button, which you find on the left-

hand side of print button in the athletes panel. If you click on this button, a new window will 

appear where you can set the parameters. 

 

 

Figure 26: Assigning start ID's 

 

• Group by 

Here you can choose whether you want to group the start ID's by club or by team. The 

advantage of this functionality is that the start ID's of the athletes that belong to one 

team/club will have a consecutive order. 
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• Gap after each group 

This option gives you the possibility to leave a gap between the numbers of two different 

teams/clubs, as spare numbers for later usage. In case you have some late additional 

inscriptions of a certain team, then these 'blank' numbers will be assigned to these late 

inscriptions. This way their numbers apply to the consecutive order of their team. 

 

• Replace existing 

In case that some athletes already had a start ID (for instance because you started a 

previous meet), you can replace their numbers by new ones by checking the check box. 

 

• Start at 

Start assigning ID numbers from a set number. 

 

• Number of characters 

The number of characters that each ID number will contain. In this case, number 1 will 

be shown as 001 (3 characters). 

 

• Prefix 

Enter the characters that you want to show before of the ID number, if desired. 

 

• Suffix 

Enter the characters that you want to show after of the ID number, if desired. 

 

4.6 Taking along competition files 

You can easily make a backup of the competition by using AthleticsManager Server. This is in 

fact a backup of the database. Make sure that the database service is activated before making 

or loading a backup. 

 

Click in the AthleticsManager Server on Make a backup of the current meet, select the 

location and choose a file name. You can for example copy this file to a safe location on your 

network or on a USB flash drive. 

 

To work again with your backup (for example on another location), you have to click on Load 

an earlier copy of a meet. Select your backup and click Open. 
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When you want to mail a backup it is better to send a zip files instead of the .amb file due to the 

security setting of most computers. 

 

To have an ideal workflow, follow these steps: 

• Fill in all preliminary data in the meet at your home pc. 

• Make a backup of this meet. 

• Make sure that the external pc has installed all required aspects of AthleticsManager. 

• Load the backup of the meet that you set in advance. 

• Fill in, during the meet, the results and so on. 

• Create a new backup of this meet. 

• Load the meet again on your home pc, or copy the backup to a backup location 

 

 

----------------------------------- 
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5. Import Athletes and Participants in AthleticsManager 

5.1 Description 

This chapter describes the feature of TimeTronics' AthleticsManager to import athletes and 

participants from any structured text file. 

 

5.2 About the Text file 

You need a structured text file, the most common type is a CSV-file (comma-separated values). 

Other files with tabulated data are fine as well. All spreadsheet software packages (like MS Excel, 

OO Calc, LibreOffice Calc, Apple Numbers, …) have a functionality to save the file as a structured 

text file. In the screenshot below, we will show you the Save As options from LibreOffice Calc. 
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5.3 Start the Import 

The import can be started from menu File->Import->Import athletes and participants. If this 

menu is greyed-out, your user-profile has not sufficient rights to import athletes and 

participants. 

 

 

 

5.4 Select the Text File and Its Properties 

You start with opening a file with the button at the right-top of the import-window. 

 

After the first lines of the file are loaded, try to find the correct settings for the separator and 

the text delimiter. To visualize a {tab}, AthleticsManager uses an arrow (→). If your text 

delimiter is different than a single (') or double quote (“) or if you don't have a text delimiter, 

you can type over the value in the drop-down list. 

 

If you have found the correct separator and text delimiter, continue with the character set. If 

you have no idea about the character set used for the text file, try to find some special characters 

(like é, å, ç, Š, ß, …) and try some character sets (UTF-8, windows-1252, ...). 

 

The setting to skip some rows at the beginning of the file, is useful when you have a header row 

with labels for each column, but as these labels might be useful when selecting the type of 

content for each column, we will keep them visible for now. 

 

If your file contains information regarding the gender of the athletes, you can define which values 

translate to male and which to female. If you don't specify anything, m and M will be translated 

to male, f, F, w and W will be translated to female. Unknown characters will be translated to 

female and if you don't specify a column for the athlete’s gender, all athletes will be male. 

 

Now we can start with selecting the type of content of each column. You do so by clicking on the 

column header and select the correct value from the pop-up menu. 



 

 

2019v1 AthleticsManager manual 

 

      

64 

 

These are all possible types: 

 

• athlete information 

o primary key: useful if you want to specify a unique identification for each athlete 

yourself 

o firstname 

o last name 

o birthdate 

o birthdate by category (a name of a category will be translated to a birthdate) 

o gender 

o nationality (by name of the country or IAAF code) 

o bib number (same as in club information): will be used in the license and in the 

competition 

o license number (same as in club information) 

 

• club information 

o name of the club 

o abbreviation of the name of the club 

o bib number (same as in athlete information): will be used in the license and in the 

competition 

o license number (same as in athlete information) 

 

• event information 

o name of the event 

o number of the event 

 

• personal best information 

o value of the personal best: a lot of possible formats or supported (1:23.45, 

1.23.45, 1'23”45, 1m23, 1.23, …) even a mix of all these formats 

o date of the personal best 

o place where the personal best was achieved 

 

• competition team information 

o name of the competition team 

o abbreviation of the name of the competition team 

o name of the competition team group 
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• relay team information 

o name of the relay team 

o order in the relay team 

 

Note that some values are pure for identification, e.g. you can only try to identify the correct 

event, you can't create a new event just by importing a text file. That is why you can only select 

one identification of an event. 

 

Also note that you can only define a type of content once. E.g. no two columns can contain the 

firstname of an athlete. 

 

Now that we defined all columns, we can hide the rows with column labels, if we had any, by 

setting the correct value of rows to skip (From row). 

 

 

 

5.5 Define the Unique Constraint 

You can define the unique constraint yourself or ignore this step and be good with the default 

choice of AthleticsManager. 

 

The unique constraint is the combination of columns the import feature will use to match an 

existing athlete with one row in the import file. 
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5.6 Translating Category Names to Birthdates 

Sometimes you don't have information regarding birthdates of the athletes, but you know the 

(age) category they are in. The import feature can translate for you the name of the category 

to a birthdate. 

 

If you selected the type of content athlete information > birthdate by category name, you will 

be presented with a window to build up a translation table between category names and 

birthdates. The window has also import/export functionalities. The syntax of the import file is: 

 

category name {tab} birthdate in yyyy-MM-dd 

e.g. 
seniors men {tab} 1990-01-01 

seniors women {tab} 1990-01-01 
juniors men {tab} 1994-01-01 

juniors women {tab} 1994-01-01 
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5.7 Inspect the Feedback 

After you clicked on Import in the previous window, the text file is processed and you are 

presented with some feedback. Note that no changes have been written in AthleticsManagers 

database yet. You could copy the feedback to the clipboard, paste it in a file and manually inspect 

if you need to do some changes to your database before executing the import. Or you can use 

the feedback windows, provided by AthleticsManagers import feature. 

 

5.8 Feedback on the Athletes 

 
You can see the number of new athletes (yellow background) and the number of athletes, the 

import feature found a match for (white background). If you believe this feedback is not correct, 

you need to cancel the import, modify your text file or your AthleticsManager database and 

restart the import. 
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5.9 Feedback on the Clubs 

In the feedback on the clubs, you can also see the number of new and already existing clubs. 

But here you can also force a match, change a match or even create the new club manually by 

clicking on the pencil in the right-most column. 

 

The new teams will be created for you automatically. The federation of the club will be the same 

as the federation of your current competition. 

 

 

 

5.10 Feedback on the Events 

You will see the number of events which AthleticsManager could not match and the number of 

events matched correctly. You can force a match or even create new events by clicking on the 

pencil in the right-most column. Note that no events are created manually, so if there are events 

without a match, the participants will not be created (the athletes however will be created). 
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You will probably want all events to exist in your database before you do the import! 

 

 

5.11 Feedback on the Competition Teams 

The feedback of the competition teams is equal to that of the clubs, you have all chances to 

create new teams, force matches, … All competition teams without match, will be created 

automatically for you in the competition you are currently working in. 

 

 

5.12 Finally Execute the Import 

 

Just click on the button do the import and AthleticsManager will write all data to the database. 
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5.13 Remark 1: relay teams 

The ‘name of the relay team’ and the ‘order in the relay team’ are two possible content types for 

a column in the file. 

 

A note for relay teams is that you don't need one line for one relay team, but you need one line 

per athlete in the relay team.  

 

An example for one relay team with 4 athletes (licensenumber;firstname;lastname;relay team 

name;order in relay team;event name): 

 

120483;Kristel;Verbeke;ACK3;2;4x100_meter_girls 

120827;Karen;Damen;ACK3;4;4x100_meter_girls 

100479;Kathleen;Aerts;ACK3;1;4x100_meter_girls 

142473;Josje;Huisman;ACK3;3;4x100_meter_girls 
 

5.14 Remark 2: Application note: Inschrijven.nl 

We would like to list some notes regarding the usage of export files from inschrijven.nl as the 

source for importing into AthleticsManager. 

 

• The output file from inschrijven.nl is an Excel file (*.xls). You will have to save it as a 

structured text file. 

 

• The output file from inschrijven.nl has no column for the lastname of an athlete. Instead, 

it is split into two columns, labeled Tussenvoegsel and Achternaam. You need to make 

an extra column and calculate the lastname. E.g. in OO Calc or LibreOffice calc, you could 

use the formula (where Tussenvoegsel is in column D and Achternaam is in column E): 

=TRIM(CONCATENATE($D1;” “;$E1)) 

 

• Athletes need to type in there licensenumber themselves, this is a major source of typos. 

So we would advice to use other columns than the licensenumber for the unique 

constraint. E.g. use a combination of firstname, lastname and birthdate. 

 

• The output file from inschrijven.nl uses one single line for a relay team, with the 

participants in numerous syntaxes in a column at the end of the file. AthleticsManagers 

import feature cannot handle this syntax, so you need to either skip the import for relay 

events, or modify the import file to the correct syntax with one line per athlete in the 

relay team. 

 

--------------------------------- 
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6. Administration during the meet 

Administration of a meet in progress happens mainly in the events administrator. Multiple events 

can be opened at the same time, and every individual event is divided into three vertical tab 

pages: Participants, Start lists and Results. You have various possibilities to manage or open 

an event, always starting from the events panel: 

 

• Double-click on an event. 

• Select an event and push [Space] or [Enter]. 

• Right-click on an event and choose Work with <event name>. 

 

Tip: To switch easily between open events, you can make use of the shortcut key [Ctrl] +[Tab]. 

 

6.1 Entering performances 

 
There are different kinds of results: 

 

• Time-related performances: 

o hand times, manual entry 

o electronic times, manual entry 

o electronic times, automatic entry (by using MacFinish) 

 

• Metric performances: 

o distances, enter only the best result 

o distances, enter every attempt 

o heights, enter only the best result 

o heights, enter every attempt 

 

• Invalid performances: 

o no result (NR) 

o disqualified (DIS) 

o did not start (DNS) 

 

Every heat runs through a series of statuses. Depending on the status, the background colour 

of this heat will change. When all heats have reached a certain status, the round to which these 

heats belong, will take over their status. 
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Status (colour) Description 

Empty (white) Contains no participations. 

Waiting (grey) Contains participations, but no results. 

Started (light blue) Event has started and results are being entered. 

Results available (yellow) All results are entered and the button Ready has been clicked. 

Official (green) The results are approved and the button Official has been clicked. 

Corrected (red) A result has been modified, although the results were already official. 

Table 4: The possible statuses that a heat or group can run through 

 
When entering the performances, you can make use of the [Enter]-key to confirm your entry 

and jump directly to the next (entry) field. By default this is the field directly below. By using 

the [Tab]-key, you can switch between the different code buttons to enter the result of an 

attempt. 

 

You can also add a note to a performance, for extra information concerning this performance. 

This is useful in case of pointing to a specific rule for a disqualification for example. To add a 

note, right-click and choose Add a note. Fill in the note text and click OK. The note will appear 

in the tool tip of that performance. 

 

It can sometimes occur that the points are not immediately calculated. You can then click on the 

button on the top right, with a green turning arrow, to recalculate the points. 

 

6.1.1 Adding wind measurement 

If you do a wind measurement by using a wind measurer (e.g. WindSpeed), you can import the 

results of it into AthleticsManager. This could be useful if you want to show whether the wind 

velocity could have influenced the final results or not. If you import the results into 

AthleticsManager, the results will be shown in a separate column named Wind measurement. 

This column is hidden by default, but can be shown by right-clicking on the column heading and 

choosing Wind measurement. The format is meter per second. 

 

6.1.2 Entering hand times 

When hand times have been used for the results, instead of electronic times, then they have to 

be filled in in the separate column Hand timing. This is necessary for the application to adjust 

the points calculation for hand times. The column is hidden by default, but can be shown by 

right-clicking on the column heading and choosing Hand timing. 
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6.1.3 Adding photofinish results 

If you have photofinish results, by using for instance MacFinish, you can import the results into 

AthleticsManager. This way you do not have to enter the results manually. The column for the 

photofinish results is hidden by default, but can be shown by right-clicking on the column heading 

and choosing Photofinish results. If you have multiple results, because you used multiple 

photofinish cameras, you can send all results to AthleticsManager. These multiple results will 

then all be shown in the photofinish results-column, separated by a slash. 

 

6.1.4 Adding reaction times 

You can also import the reaction times of the athletes into AthleticsManager, after you have 

measured these by means of the FalseStartIII for instance. The column Reaction times is 

hidden by default, but can be shown by right-clicking on the column heading and choosing 

Reaction times. If you have multiple reaction times, because of a false start for instance, you 

can send all reaction times to AthleticsManager. These reaction times will then all be shown in 

the reaction times column, separated by a slash. 

 

6.1.5 Entering electronic times manually 

Entering electronic times manually can be done by selecting a performance field and starting to 

type. Valid characters are 0 up to 9 for numbers, : and ; to distinguish hours/minutes/seconds, 

and . and , to distinguish seconds/milliseconds. 

 

There is also a shorter version of entering times manually, in which the hours/minutes/seconds 

are automatically separated by a colon. 

For example: entering ‘123.45’ becomes ‘1:23.45’. 

 

6.1.6 Entering electronic times automatically 

It is possible to import electronic times automatically from MacFinish-compatible products into 

AthleticsManager. 

 

6.1.7 Entering metric performances: Best performances vs All attempts 

By default AthleticsManager is set to register all the attempts. You can modify this to enter only 

the best performance. You can switch between these two modes by using the button left on top 

in the Results-tab. When the icon stands on n (by default), you are in the mode to fill in all 
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attempts. In the other case the icon will stand on 1, which indicates that only the best 

performance can be entered. 

 

Entering only the best performance is the same as entering times in the performance field, but 

this time with metric data with meter as unit. Then the colon is not used here, but the decimal 

point still is. 

 

When you enter all attempts, you get the possibility to switch between entry directions. As 

mentioned before, you can enter easily by using the [Enter]-key. By default the entry field 

jumps to the field directly underneath the current field. This is the vertical entry of performances, 

but also the horizontal entry is possible. To switch between entry directions, you click on the 

button at the top right, with a green arrow pointing below or to the right (not turning). If the 

arrow pointing below is visible, then the vertical entry is active. If the arrow pointing to the right 

is visible, then the horizontal entry is active. 

 

6.1.8 Entering multiple distance attempts 

Note: Make sure that for this, you are in the Enter all attempts-mode, otherwise you cannot 

enter multiple attempts. You can find the attempts at the right in the list with results. It is 

possible that you first have to scroll to the right. 

 

The number of attempts that is shown here, can be modified in the round properties (on the 

right side of the tab in the opened Event > Rounds > Field event). The best attempt will 

automatically be filled in in the Performance-field. 

 

You have three possible values for entering the performance of an attempt, plus possibly an 

entry field for wind measurement (depending on the event type). Possible values are metric 

values, 'X', or '-'. 

 

• The metric performance is the obtained distance in meter, to be entered with numeric 

keys ([0] up to [9]) and if necessary a decimal differentiator ([ . ] or [ , ]). 

 

• The 'X' stands for 'fail' and has to be entered by using the corresponding button or the 

shortcut keys [X] or [∗]. 

 

• The '-' stands for 'pass' and has to be entered by using the corresponding button or the 

shortcut key [ - ]. 
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6.1.9 Entering multiple height attempts 

Note: Make sure that for this, you are in the Enter all attempts-mode, otherwise you cannot 

enter multiple attempts. You can find the available heights at the right in the list with results. It 

is possible that you first have to scroll to the right. 

 

The height columns that are shown here, have to be added yourself by using the button New 

height at the top left. Adding according to height means that the entered height will stand on 

its linear place between the height columns. 

 

Adding by barrage means that the entered height will be placed behind the height columns. By 

default the start height will be present as height column. The start height and the default interval 

with which the heights have to be incremented, are both adjustable in the round properties (on 

the right side of the tab in the opened opened Event > Rounds > Field event). The 

Performance-field will be filled in automatically with the highest reached height. 

 

You have three possible values for entering the performance of a height attempt. Possible values 

are '0', 'X', or '-'. 

 

• The '0' stands for 'success' and has to be entered by using the corresponding button or 

the shortcut key [0]. 

 

• The 'X' stands for 'fail' and has to be entered by using the corresponding button or the 

shortcut keys [X] or [∗]. 

 

• The '-' stands for 'pass' and has to be entered by using the corresponding button or the 

shortcut key [ - ]. 

 

Note: The barrage heights are not taken into account yet in the calculation of the place, so you 

have to modify the place manually (if necessary). This functionality is planned for a next version 

of AthleticsManager. 

 

6.1.10 Entering invalid performances 

When a participant had no result (NR), was disqualified (DIS), or did not start (DNS), then you 

can enter this by right-clicking on the performance field of that participant and choosing the 

desired option in the sub menu Use code. 
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6.1.11 Entering results (simple insertion) 

 

 

In the results tab of an event, an extra button has been placed to add results in a simple and 

fast way. This mode bypasses all the steps in setting up an event where you should first add 

participants, next seed them in heats/groups and finally fill in the results. Here you can add a 

participant, seed it and fill in the result all in 1 step. You should keep in mind that the order of 

entering is also the ranking of the participants. This method of filling in results can be handy for 

e.g. a cross-country event. 

 

Fill in the name, bib or license number of the participant in the search field. AM will present you 

the results in the table. Double-click on the correct participant so it gets filled in. Now press the 

+ button to add the participant. If desired you can also add the performance, info and wind 

measurement of the result. 

 

A faster way to enter the results would be by making use of the keyboard. After searching a 

participant, press [Tab] to enter the list.  Move to the appropriate participant and press [Enter] 

to select the participant. Press again [Tab] to set the focus on the + button. After pressing 

[Enter], the participant is added to the results and the search field will get the focus back for 

searching a next participant. 

 

When a participant is not listed in the database, you can also add a new athlete in this window. 

Click on the new athlete button that will open some text fields to insert a new athlete to the 

database. 
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6.1.12 Entering penalties 

When a participant has committed a penalty and the judges have given a penalty card, you can 

enter this by right-clicking on the performance field of that participant and choose the desired 

option in the sub menu 'Use penalty code'. You can choose a yellow card (YC), 2nd yellow so red 

card (YRC) or a red card (RC).You can also enter the reason for this penalty card. The card will 

be displayed at the end of participant's name. Hovering on the card will display the reason of 

the card and in which round the card was given. 

 

The penalty can also be printed in the participations list and results list when the appropriate 

tag has been added to the template. Please check the printtemplate manual on our website  for 

an extended list of all available printtemplate tags. 

 

6.2 Universal and mixed events 

 

 

An universal event is defined as en event where men and women participate together without a 

seperate classification of results. A mixed event is defined as en event where men and women 

participate together but with the possibility to have a seperate classification of results. 

 

In AM, it is possible to add both men and women as participants to an event. If this is the case, 

the results tab will display a filter option to display the results of only male, only female or both 

participants. The ranking will be recalculated depending on the selected filter. 

If you want to print a mixed event filtered on gender, the document will state that this is a partial 

result so you don't get confused about the full result. 
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6.3 Point calculation 

Point calculation is necessary to obtain a ranking in combined events. Each result of an event 

corresponds to several points. The total points of all events will result in the end ranking of the 

combined event. 

 

In extension point calculation can also be used to compare performances between athletes no 

matter the event type. 

 

6.3.1 Individual points 

The individual points are calculated based on an implemented formula. This formula is set in 

advance. 

 

6.3.2 Team points 

Next to the individual points you can find the team points. It depends on the round properties 

whether team points will be assigned to that participation or not. If you select not assigned, 

then no team points will be assigned. 

 

The obtained points are only added to the subtotal of the team points of that team if the heat 

has the status 'official'. You can print the subtotal of the team points at all times by using the 

button Print in the teams panel. 

 

6.4 Qualification rounds 

If you have chosen a qualification method in the round properties, then the correct participations 

are automatically qualified for that round. The qualifications on place are indicated by a Q on 

the left side of the participation result. The qualifications on time are indicated by a q. 

You can however still modify the qualifications, by right-clicking on the qualification field. 

 

Once the results are official, you can go back to the tab page Start lists, select the concerning 

qualification round, and click on the button Qualification. The qualified participations are 

automatically transferred to the next round. You will still need to add heats! 
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6.5 Personalized menu 

A personalized menu, in which every federation can use its own personalized functions, has been 

implemented in AthleticsManager. This menu is indicated by the logo of the federation. If you 

click on this menu, you will see the different functions. 

 

 

----------------------------------------- 
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7. Global settings 

The global settings have already been set correctly by TimeTronics, for your user friendliness. It 

concerns mainly a digital collection of the rules and parameters that are used by the athletics 

federation of your region. Although these values are not visible for users by default, they are 

completely adjustable to your needs. You can use this for example by adding an own event type 

with your own chosen point calculation parameters. 

 

Only a superuser has the privileges to change the global settings. This is set for safety reasons, 

so that not everybody can ‘accidentally’ or intentionally change the settings during the meet. 

 

You can find all the global settings in the superuser bar. To make the superuser bar visible, 

see 3.2.4 Modifying interface. There is a separate button per group settings: Event types, 

categories, Clubs, Point calculation, Correction factors, Users, Federations, 

Nationalities, Languages, Seeding methods, Qualification methods, Teampoints 

calculationmethods. 

 

 

7.1 Event types 

All normal event types are installed by default. You can however add new types, or modify or 

delete existing types. Examples of event types are: Discus 1.000kg, 110m Hurdles 0.914m, 

Javelin 600g, etc. The default event names that are being used, will only apply if no translation 

was entered. For each of these event types you can of course make a personalized translation. 

 

 

Table 5: Modify the event types in the Event types-window 

 
• Name code 

An ID code that is used for translations of the full name of this event type. 
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• Abbreviation code 

An ID code that is being used for translations of the abbreviation of this event type. 

 

• Venue 

Specifies if this is an indoor or outdoor event type. Possible values are I (indoor) and O 

(outdoor). 

 

• Distance 

The distance as an integer for distance event types (by default 0). 

 

• Wind mode 

Specifies how the wind measurement has to be executed. Possible values are N (not), H 

(per heat) and I (per individual performance). 

 

• Wind type 

The number of seconds (integer) that has to be measured for the wind measurement. 

Mostly this is one of these values: 5, 10 or 13. 

 

• Precision 

Specifies the accuracy (decimal) of the performance. Possible values are 1 (integer), 10 

(one tenth), 100 (one hundredth), 1,000 (one thousandth) and 10,000 (one ten 

thousandth). 

 

• Type of field event 

Specifies the type of field event for this event type. Possible values are (no field event), 

H (horizontal field event) and V (vertical field event). 

 

• Correction for manual timing 

The value that is added to the entered hand times to be used in the point calculation. 

 

• Number of athletes 

The number of athletes that works together to accomplish a performance. This is by 

default 1, with a relay event this is usually 4. 

 

• Implement 

The weight factor that has to be used in the calculation (in kilogram). The weight of the 

goods with throwing events is of importance here. Decimal values are possible. 
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• Number of events for combined events 

The number of events (integer) that this combined events- eventtype contains. Only 

applicable to combined events-eventtypes. 

 

• List of field events 

Semicolon-separated list of event types that will be used as events for this combined 

events-eventtype. Only applicable to combined events-eventtypes. 

 

• By double-clicking on the corresponding field in the List of field events-column or 

Number of events for combined events, you open a new window in which you can 

create new or modify existing combined events. 

 

 

Figure 27: Configure or create a combined event 

 
In this window you can add event types to your combined events by selecting the desired event 

in the left column, and then clicking on the right arrow. Deleting event types can be done by 

selecting the event type in the right column, and then clicking on the left arrow. 

 

You can arrange the event order by using the arrows on the right-hand side of the window. 

 

If you then click on OK, you will see the values in the Event types-window change. 
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• Default name 

The system name of this event type. If no translation for your defined language is 

entered, then the system name will be used. 

 

• Default abbreviation 

The default abbreviation of this this event type. If no translation for the abbreviation of 

this event type is entered, the default abbreviation will be used. 

 

• Sort 

Specifies the method by which performances should be sorted. Possible values are false 

(descending) or true (ascending). 

 

• Name (*) 

The name, translated into language *, for this event type. 

 

• Abbreviation (*) T 

The abbreviation, translated into language *, for this event type. 

 

7.2 Categories 

The categories are defined in this window. The categories are grouped by federation. There has 

to be a separate category per gender, so for one age category there will always be two instances. 

For example: Masters men and Masters women. 

 

 

Figure 28: Manipulate the categories in the window Categories 
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• Name 

The name of the category. 

 

• Abbreviation 

The abbreviation of the category. 

 

• Gender 

The gender of the category. Possible values are M for masculine and W for feminine. 

 

• Minimum/maximal type 

The type that is used to check the age limit for minimum/maximum. Possible values are 

N (no minimum/maximum limit), D (limit control by date of birth) or Y (limit control by 

year of birth). 

 

• Minimum/maximal age 

The value that is used to check the age limit for minimum/maximum. 

 

7.3 Clubs 

The athletic clubs are defined in this window. The clubs are grouped by federation. 

 

 

Figure 29: Club window 

 

• Name 

The name of the club. 

 

• Abbreviation 

The abbreviation of the club. 
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• Federation number 

The identification number under which the club is being registered by the federation. 

 

• Place 

The home base of the club. 

 

7.4 Point calculation 

The point calculation rules are defined in this window. The rules are grouped by point calculation 

method. For an extensive definition of point calculation methodology, see section 6.2 Point 

calculation. 

 
There are 2 ways how points get calculated. 

• using an algorithm 

• using a lookup table 

 

7.4.1 Using an algorithm 

There are 4 methods predefined for performing the point calculation using an algorithm. The 

algorithm uses variables which will be retrieved from the point calculation parameters table and 

filled in the alg. These parameters are specific for event type and category. 

 

Name Algorithm 

IAAF JUMP INT(%1*POW(100*(%0-%2),%3)) 

IAAF RACE INT(%1*(POW((%2-%0),%3))) 

IAAF THROW INT(%1*POW(%0-%2,%3)) 

IPC INT(%1*E^(-E^(%2-%3*%0))) 

 

Valid operations 

• INT: Parse a string argument and return an integer 

• POW(x, y): Returns x raised to the power y 

• SQRT(x): Returns the square root of x 

• E^:(x) Returns the base-e exponential function, e to the power x 
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Parameters 

• %0: result * correction 

• correction: parameter of recalculate results parameters table specific for event type and 

category 

• %1: parameter 1 of the point calculation parameters table 

• %2: parameter 2 of the point calculation parameters table 

• %3: parameter 3 of the point calculation parameters table 

 

7.4.2 Using a lookup table 

For some event types and categories a lookup table is used to calculate the points of an athlete. 

 

Figure 30: Point Calculation Window 

 

• Event type 

The event type to which these rules should apply. 

 

• Category 

The category to which these rules should apply. 

 

• Parameter -N- 

The parameter values which will be entered in the internal point calculation algorithms. 

 

7.5 Correction factors 

The correction factors are defined in this window. The correction factors are grouped by 

federation. The correction factors are optionally used in the point calculation formula. For an 

extensive description of correction factors, see section 7.4 Point calculation. 
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Figure 31: Correction factor window 

 

• Event type 

The event type to which this correction factor should apply. 

 

• Category 

The category to which this correction factor should apply. 

 

• Correction factor 

The value of the correction factor. (by default ‘1’) 

 

7.6 User profiles 

This window shows the different user profiles, with each their own specifications and privileges. 
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Figure 32: User Profile Window 

 

In the left part (Users) you can see the existing users listed. Adding and deleting is possible 

through the according buttons at the bottom of this list. You can only add and delete users when 

you have the privileges for this. Only the superuser can do this by default. The superuser, 

advanced user and beginner user are always present and cannot be deleted. When you add a 

new user, the privileges of the current selected user will be copied to the new account. 

 

In the right part (User options) you see a list of the user privileges. 0 means 'not allowed', 1 

means 'allowed'. 

 

You can use the button Change password to change the password for the current selected 

user. Unless you are a superuser, you do not need to enter an old password. 

 

7.7 Federations 

The different federations with each their own specifications are described in this window. You 

can add new or delete existing federations by using the buttons on the top right-hand side of 

the window. 
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Figure 33: Federation Window 

 

• Name 

The name of the federation. 

 

• Abbreviation 

The abbreviation of the federation. 

 

• Code 

A system code that is used for the federation. 

 

• Language 

The language of the federation. 

 

• Country 

The country of the federation. 

 

• Season start 

The date of the start of the season. If an athlete participates in a meet after this date, 

then his/her category will be determined based on the athlete's age on the reference 

date. 

 

• Reference date 

To determine the athlete's category, the category calculation will use the athlete's age 

on this date. 
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7.8 Nationalities 

This window contains all nationalities with each their own code and specifications. You can add 

new or delete existing nationalities by using the buttons on the top right-hand side of the 

window. 

 

 

Figure 34: Country-window 

 

• Name 

The name of the country. 

 

• Flag 

The flag of the country. 

 

• ISO 

An international code, consisting of two characters, that belongs to the country. 

 

• ISO3 

An international code, consisting of three characters, that belongs to the country. 

 

• Numeric code 

System code that is used by the application to define the country. 

 

• Area 

The continental federation to which the country belongs. 
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7.9 Languages 

This window contains the different languages that are implemented in AthleticsManager. You can 

add new or delete existing languages by using the buttons on the top right-hand side of the 

window. 

 

 
Figure 35: Modify the languages in the Languages-window 

 
• Language 

The name of the language. 

 

• Code 

An abbreviated code that is used for that language. 

  

7.10 Seeding methods 

This windows defines the different seeding methods. You can add new or delete existing methods 

by using the buttons on the top right-hand side of the window. 

 

There are 3 seeding methods installed regarding the heat composition: 

• IAAF seeding method 

• on best performance 

• not assigned (randomly divided) 

 

A comprehensive explanation can be found in appendix C. 
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Figure 36: Modify the seeding methods in the Seeding methods-window 

 

• Name 

The name of the method. 

 

• Algorithm 

The formula of this method. 

 

7.11 Qualification methods 

 
This window defines the different qualification methods. You can add new or delete existing 

methods by using the buttons on the top right-hand side of the window. 

 

There are 2 qualification methods possible: 

• PLACE;TIME 

• PRESTATION;MINIMUM_PARTICIPANTS 

 

Qualification methods are stored in the database as also the parameters for the qualification 

method. It is possible to set a qualification method for each event and round or for a specific 

event or round. 

 

Examples: 

PLACE;TIME: 

When place and time is chosen as qualification method and the parameters are set to 3;3 

this means that the first 3 places of each heat will go to the next round but also the 3 

best losing times. 
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PRESTATION;MINIMUM_PARTICIPANTS: 

When prestation and minimum_participants is chosen (long jump) and the parameters 

are set to 6,5;8 this means that each participant with a result of at least 6,5 m will go to 

the next round and a minimum of 8 participants. In case only 6 athletes succeed in 

jumping more then 6.5 m, then the 2 best losing results will also go to the next round. 

 

 

Figure 37: Modify the qualification methods in 

 

• Name 

The name of the method. 

 

• Algorithm 

The formula of this method. 

 

7.12 Team point calculation methods 

This window defines the different methods that are used to calculate team points. You can add 

new or delete existing methods by using the buttons on the top right-hand side of the window. 

 

There are 4 team point calculation methods defined: 

• RESULT 

• PLACE 

• MEDALS 

• COMBINED 

 

RESULT: 

The team points are calculated based on the performance of an athlete. Using an algorithm or a 

lookup table the team gets points according the result. 
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PLACE: 

Team points are given according the team settings in the competition properties window. By 

selecting a group you can set the team points according the ranking, how to calculate the team 

points in case of a tie of an athlete or a team. 

 

MEDALS: 

For each round, the team point medals 'G'(old), 'S'(ilver) and 'B'(ronze) are handed out. 

 

COMBINED: 

Team points will be calculated as if it was a combined event. 

 

 

Figure 38: Modify the methods for team points calculation in the Teampointcalculationmethods-window 

 

• Name 

The name of the method. 

 

• Algorithm 

The formula of this method. 

 

------------------------------------------ 
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Appendix A: Personalised Menu 

 
In this chapter you can find the personalised menu for AthleticsManager software. Please note 

that the explanation is only in the language requested by the specific organisation/Federation. 

 

------------------------------------ 

 

Atletiekunie-menu 

Het Atletiekunie-menu is het gepersonaliseerde menu voor de Atletiekunie. Dit menu 

heeft het logo van de Atletiekunie, en bevat drie verschillende functies: exporteren (naar 

CSV-file), controleren van de wedstrijd en het afdrukken van startetiketten of diploma's. 

 

Exporteren 

In het Atletiekunie-menu kan u drie zaken exporteren: de deelnemers, de resultaten en 

de teampunten. Als u op één van deze mogelijkheden klikt, opent er een kader waar u 

de locatie kan kiezen naar waar u het bestand wil exporteren. Het formaat van dit bestand 

zal standaard een CSV-bestand zijn. 

 

Wedstrijd controleren 

Met behulp van deze knop kan u de applicatie doen controleren of de algemene 

parameters (3) niet overschreven zijn. De applicatie gaat dan controleren dat: 

de teams niet meer deelnemers bevatten dan het maximum aantal deelnemers; 

de atleten het maximum aantal toegestane onderdelen niet hebben overschreden; 

de ploegen niet meer atleten hebben ingeschreven dan toegestaan voor een bepaald 

onderdeel. 

 

Startetiketten afdrukken 

Dit was tot voordien nog niet mogelijk, maar deze functie is ondertussen 

geïmplementeerd. Een kleine handleiding over het afdrukken van startetiketten vindt u 

in appendix F. 

 

Diploma's afdrukken 

Dit was tot voordien nog niet mogelijk, maar deze functie is ondertussen 

geïmplementeerd. Een kleine handleiding over het afdrukken van diploma's vindt u in 

appendix G. 

 

------------------------------------ 
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LBFA-menu 

The LBFA-menu is the personalised menu forr LBFA. The menu has tht logo of LBFA, and 

contains four different functions: Export to MRES, Export to XML, Upload to LBFA and 

Create your own combined event. 

 

Export to MRES 

An MRES file of the competition is created by using this function. 

 

Export to XML 

An XML file of the competition is created by using this function. 

 

Upload to LBFA 

With this function, you can upload the results of the competition to LFBA.  Depending on 

some conditions, a print-out, MRES, XML and backup file is generated before these files 

will be uploaded to the LBFA server. 

 

Create your own combined event 

You can create your own combined event type by using this function. You will be 

presented a window where you have to select a combined event as a base for your own 

combined event. Next you need to select all desired settings of the new combined event 

(name, federation, categories, events, ..._). 

 

------------------------------------ 

 

VAL-menu 

 

Het VAL-menu is het gepersonaliseerde menu voor de VAL. Dit menu heeft het logo van 

de VAL, en bevat vier verschillende functies: Export naar MRES, Export naar XML, 

Importeer atleten van SHIN en diploma's. 

 

Export naar MRES 

Met deze functie worden een MRES bestand van de wedstrijd gemaakt. 

 

Export naar XML 

Met deze functie worden een XML bestand van de wedstrijd gemaakt. 
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Importeer atleten van SHIN 

Met deze functie kunt u atleten in AM Server importeren aan de hand van een SHIN 

bestand. Hiervoor selecteert u best de encodering CP-1252 zodat alle karakters correct 

in de database verschijnen. 

 

Diploma's 

Met deze functie kunt u diploma's afdrukken. Een kleine handleiding over het afdrukken 

van diploma's vindt u in appendix G. 

 

 

------------------------------------ 
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Appendix B: Entering categories 

 

Example 1: 

Club AV1 sends out one mixed team of the Juniors category. The meet contains only juniors. 

The correct composition will be: 

 

Name: AV1 

Group: Juniors 

Default club: AV1 

Default categories: 

• Juniors men 

• Juniors women 

  

------------------------------------ 

 

Example 2: 

Club AV2 sends out two teams of the juniors category. Men and women separately. The meet 

contains only juniors. The correct composition will be: 

 

Name: AV2 

Group: Juniors men 

Default club: AV2 

Default categories: 

• Juniors men 

 

Name: AV2 

Group: Juniors women 

Default club: AV2 

Default categories: 

• Juniors women 

   

------------------------------------ 

 

Example 3: 

Club AV3 sends out five teams of Juniors and Masters category. Men and women separately, 

Juniors women has two teams. The meet contains both masters and juniors. The correct 

composition will be: 
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Name: AV3 MM 

Group: Masters men 

Default club: AV3 

Default categories: 

• Masters men 

 

Name: AV3 MW 

Group: Masters women 

Default club: AV3 

Default categories: 

• Masters women 

 

Name: AV3 JDM 

Group: Juniors men 

Default club: AV3 

Default categories: 

• Juniors men 

 

 

Name: AV3 JDW 1 

Group: Juniors women 

Default club: AV3 

Default categories: 

• Juniors women 

 

 

Name: AV3 JDW 2 

Group: Juniors women 

Default club: AV3 

Default categories: 

• Juniors women 

 

------------------------------------ 
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Appendix C: Methods of heat composition 

The heat compositions are based on an implemented method, which you can choose. There are 

two possible methods by default regarding the heat compositions: 

 

• iaaf seeding method: Heat composition in which the participants with the best (rank 

1) and poorest performances are divided over the different heats. 

 

For example: there are 12 participants and 4 available lanes. Then the heat composition 

will be as follows (the number defines the rank): 

– Heat A: 1, 6, 7, 12 

– Heat B: 2, 5, 8, 11 

– Heat C: 3, 4, 9, 10 

 

• on best performance: Heat composition which groups together the participants with 

the best performances, the poorest performances, and in between. This way the 

participants will be more matched per heat. 

 

For example: there are 12 participants and 4 available lanes. Then the heat composition 

will be as follows (the number defines the rank): 

– Heat A: 12, 11, 10, 9 

– Heat B: 8, 7, 6, 5 

– Heat C: 4, 3, 2, 1 

 

• <not assigned>: No specific method. The participants are randomly divided over the 

heats. 

 

Note: Alternative seeding methods can be downloaded from our website. By using the seeding 

methods button in the superuser menu, you can load the alternative seeding method plugin into 

AthleticsManager Server. From that point, you can select the new seeding method in each event. 

 

 

------------------------------------ 
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Appendix D: Entering electronic times automatically 

In case you are using MacFinish product for electronic timing, you can export these data to the 

AthleticsManager database. To see which data is sent, you can open the MacFinish panel through 

the menu Window > MacFinish. You can still change received results if necessary by 

overtyping the concerning field. 

 

To directly send electronic times from MacFinish, you need at last MacFinish version 6.x, 7.x or 

8.x. 

 

Set-up 

The diagram below explains how the communication works between the different pieces of 

software and how your set-up has to be. The COM-connection works through a serial connection, 

the UDP-connections work through a network. There are various set-ups possible: you can install 

all software on one system or you can install the different software parts on different systems, 

according to your preference. 

 

 
Figure 39: The required connections for the link 

 
When you want to use MacFinish 6.x, you first start AthleticsManager Serial-Link, you choose a 

desired AthleticsManager Server, and the COM-port you want to use. 
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Figure 40: Use AthleticsManager Serial-Link to connect with MacFinish 6.x 

 

The use of the electronic timing program is not discussed here. You can find an overview of how 

the communication works in MacFinish 7.x and MacFinish 8.x, via the direct link. For the 

MacFinish 6.x it is the same process, but then you select Hytek compatible as meetmanager. 

 

Setting up MacFinish for use with AthleticsManager 

First make sure that the AthleticsManager Server is running. Start MacFinish, and go to the menu 

File > Preferences. In the tab page Meetmanager you select the meetmanager 

AthleticsManager. Two new fields will appear: Server and Competition. For Server you 

choose the name that you gave your AthleticsManager Server (just like selecting in the 

AthleticsManager Client). For Competition you choose the meet name where you want to work 

with. 

 

 

Figure 41: The properties in MacFinish to use AthleticsManager 
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Sending electronic times of MacFinish to AthleticsManager 

Start just like you usually work with MacFinish. After you have made your photofinish image, 

the import dialogue window will automatically appear on your screen. If not, you click on the 

menu Document > Import. Choose the heat that belongs to this photofinish image. The 

participations are imported in MacFinish and the file name is automatically placed correctly. Place 

in MacFinish the time lines on the correct locations, so the electronic times are registered. When 

all the times are registered, you click in the menu on Document > Export. The electronic times 

are now exported to AthleticsManager. 

 

 

Figure 42: Dialogue window to import an AthleticsManager heat into MacFinish 

 

When you had an opened AthleticsManager Client, you will first see a notification in the MacFinish 

panel that the electronic times are available. These will then be processed in a few seconds in 

the according heat. 

 

 

------------------------------ 
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Appendix E: Formula for point calculation 

AthleticsManager calculates the points based on an implemented formula: 

 

result= POINTSCALC( ROUND( prestation× correction) ) 

 

result the result as individual points; 

POINTSCALC the point calculation function; 

ROUND the rounding function; 

prestation the delivered performance (physical measurement result); 

correction the correction factor which has to be multiplied with the performance if 

necessary. 

 

The correction factor Correction depends on the participation category. The correction factor of 

that participation category is only taken into account, if the correction factor of that specific 

participation category is added in the round properties (Properties > Point calculation). In 

all other cases, this is simply the value ‘1’. 

 

The rounding function ROUND depends on the precision of this event type. The dependencies 

of the correction factor have an indirect effect on the result of this function. 

 

The point calculation function POINTSCALC depends on the event type (various formulas per 

event type), the participation category (various parameters per category for the formula of the 

event type) and the used point calculation method in the round properties. The dependencies of 

both the correction factor and the rounding function also have an indirect effect on the result of 

this function. 

 

--------------------------------------- 
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Appendix F: Startetiketten (BIB) afdrukken 

Ga naar het logo van de federatie en kies Startetiketten afdrukken. 

Je krijgt het onderstaande venster. 
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Je kan filters toepassen om te bepalen welke etiketten je wil printen. Zo kan je filteren op naam, 

startnummer, team, ploeg en categorie. 

De gevonden deelnemers worden getoond in de tabel. 

Vink daarna aan van welke deelnemers je de startetiketten wil afdrukken. 

 

Selecteer het sjabloon dat je wil gebruiken voor de print-out. Daarna kan je nog een printer 

toevoegen en specifiëren hoeveel kopieën er moeten worden gemaakt. Standaard gaat de 

applicatie eerst een bestand genereren en daarna afdrukken. 

 

 

--------------------------------------- 
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Appendix G: Diploma's 

Ga naar het logo van de federatie en kies Diploma's 

Je krijgt het onderstaande venster. 
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Je kan filters toepassen om te bepalen welke etiketten je wil printen. Zo kan je filteren op naam, 

startnummer, team, ploeg en categorie. 

De gevonden deelnemers worden getoond in de tabel. 

Vink daarna aan van welke deelnemers je de diploma's wil afdrukken. 

 

Selecteer het sjabloon dat je wil gebruiken voor de print-out. Daarna kan je nog een printer 

toevoegen en specifiëren hoeveel kopieën er moeten worden gemaakt. Standaard gaat de 

applicatie eerst een bestand genereren en daarna afdrukken. 

 

 

--------------------------------------- 
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